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Program Version

The product described in this manual holds software. This manual corresponds to:
» Software version 3.1

It was released in 2015.

Product and Documentation Changes

Big Dutchman reserves the right to change this manual and the product described herein without further
notice. In case of doubt, please contact Big Dutchman.

Date of change appears from the back page.

Note

« All rights reserved. No part of this manual may be reproduced in any manner whatsoever
without the expressed written permission of Big Dutchman in each case.

+ Big Dutchman has made reasonable efforts to ensure the accuracy of the information contained
in this manual. Should any mistakes or imprecise information occur in spite of this, Big
Dutchman would appreciate being notified thereof.

« lrrespective of the above, Big Dutchman shall not have any liability with respect to loss or
damage caused or alleged to be caused by reliance on any information contained herein

» Copyright 2015 by Big Dutchman.
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PRODUCT DESCRIBTION

BigFarmNet Export is a tool that is part of the BigFarmNet PC management system. It lets the user export

data from their BigFarmNet systems into CSV files or databases. The data can be imported into
BigFarmNet EPM (Enterprise Performance Management), Excel or be used in business systems.

BigFarmNet Manager

Fl % WebAccess licanse
% BigFarmNet Export

BigFarmNet Manager

J

WebAccess license
BigFarmNet Export

= —

BigFarmNet Manager

WebAccess license
BigFarmNet Export

= —

BigFarmNet Export uses WebAccess to retrieve data from farms or enterprises. Therefore a WebAccess

license is required for BigFarmNet Manager at each farm.

BigFarmNet WebExplorer

export.csv
database.

BigFarmNet EPM

\

| WebAccess System | Expcrt Type | Last OK Export | Last Export
T ST ] o

e u -28 23:00 ”2015—01 -2313:52

= Delete
Copy

a Export
Historical Export

| Next Run
| 2015-01-23 23:00

‘ Status of Last Ex... |
|[Offline. '

Export Missing - BDTest: Start of Export ....

Figure 1: Example of BigFarmNet Export with a list of different WebAccess configurations
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USER GUIDE

1 Installing BigFarmNet Export on a PC

Install the program on all the PCs, from where you want to export data.

He fedor t Foeire Fnkiors o o

Qi - ) - (| Do iy sewow | - |

Mee [ L
alvnn - | Storvese | Type | Zrcret den

- camappeopgaver A | it DT ———

B — |
et Widows el i S 9,7V e o 010008 115,78 @ et 2
78] BigFarmNet Export Setup el s

= Welcome to the BigFarmNet Export Setup
Wizard

‘The Setup Wizard wil install BigFarmiNet Expart on yeur
computer, Click Next to continue or Cancel to exit the Setup
Wizard

) BigFarmNet Export Setup el s
- { @
1 END USER LICENSE AGREEMENT FOR BIG DUTCHMAN
SOFTWARE PRODUCTS

IMPORTANT — READ CAREFULLY: This Big Dutchman Softwars Development End
User License Agreement (EULA™) is a legal agreement between you (ether an
individual or a single entity) and Big Dutchman International GmbH (BDI) for the

]
software product ideggied above, which inclug uter software and associated
imedia and printed ggfferials, and may inci lectronic documentation
SOFTWARE GIDUCT™ or "SOFTWARE"). By instaling, copying, or otferwise using

the St PRODUCT, you agree to be bound by the terms of this EULA. If you do
not 0 the terms of this EULA, promptly return the unused SOFTWARE -

[#]1accept the terms in the License Agreement

[ et | [ Back [ mext | [ canca |

1) BigFarmNet Export Setup el

_wdrk(hange e @

Install BigFarmNet Export to:

|c \Program Files (x36)'Big Dutchman \BigFarmiet Export,

75! BigFarmNet Export Setup e

= Completed the BigFarmNet Export Setup
Wizard

Click the Finish button to exit the Setup Wizard.

ok Conce

1) Install the BigFarmNet Export program on a PC by double
cliking on Setup.exe.

2) Click Next.

3) Read the licence agreement terms and click I accept the
terms... and Next to accept them.

The installation file saves the program in the folder C:\Program
Files\ Big Dutchman\BigFarmNet Export.

If you prefer a different file location, please click Change to access
the new location in the directory.

4) Click Next.

5) Click Finish when the installation is completed.
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2 BigFarmNet Export User Interface

Open the BigFarmNet Export program.

| WebAccess System | Export Type | Last OK Export | Last Export | Next Run | Status of Last Ex... |

Export Missing - BDTest: Start of Export ...

In the BigFarmNet Export window the user can manage the data configurations, that are used for
exporting data from the BigFarmNet system to other systems.

All configurations are listed with an indication of time and status for the exported data. The scheduled
automatic export can be disabled by removing the marker from the checkbox.

Icon/Menu

Description

The Configuration menu — or right-click a configuration.

Add a new configuration.

Add

Edit an existing configuration.
Edit g contig

Remove an existing configuration.
Delete

Copy a configuration.
Copy py g

Export data to a file.
Export

A file is saved to the path in the configuration or to a path selected by user.

Historical Export

Export of historical data for a selected interval.

EE OEINE

Close the BigFarmNet Export window and minimize in the taskbar tray.

Close
Automatic data export will still be carried out. To resize the BigFarmNet Export
window, click the icon on the taskbar tray.
Exit The File menu. Exit the BigFarmNet Export program.
Xi
The data export is running as a Windows background service and will ensure that
data are still exported according to the configurations made in BigFarmNet Export.
& MySQL DB The Settings menu. Parameters for connecting to the database.
e The Settings menu. Parameters for connecting to the database.
SQL Server
? Help The Help menu. Open a document with links to program documentation.
/i.‘ The Help menu. Show company copy right information and BigFarmNet Export
About version number.

@ Biq Dutchman

BigFarmNet Export




8 User Manual

3 Setting up an Export Configuration

T +I
g e e g i Click + Add or y Edit in the top tool bar.

Hie (Config atl o
2 bl o : ngs

= D /5 - This opens the BigFarmNet Export Wizard, that will guide you
through the setup of the configuration.

3.1 WebAccess Address

The first step in setting up a new configuration is selecting or typing an address of a running BigFarmNet
system with WebAccess eanbled.

An address for a new WebAccess system must be entered manually. If the WebAccess system is already
used for an existing configuration the system can be picked from a list of known systems.

BigFarmNiet Export Wizard x

Specify Big address and

_ Select a known system or create new

Known WebAccess systems:

Name | Address User name

WebAccess URL [ |
URL is Not OK

User name: =) |
User name is missing

Password: [ |

System name:

Status: & offine

3.1.1 New System - Manual Setup

Webecess URL | PitpiwemshoBD mpadtiydeme | Enter WebAccess URL, user name and password.
User name: [adrmin \ Standard user name: guest
Password: \ | The user name and password must correspond to a user profile in
Geemrame Fam the BigFarmNet Manager User Management.
| S & oniie | Status will change to Online when BigFarmNet Export has

successfully connected to the WebAccess connection.

The configuration is saved to the list of known systems when Next
is clicked.

3.1.2 Known System — Select Setup

Known WebAccess systems:

Mo e Tre— Doubleclick on a known system to select it from the list and copy
it to the manual setup.

Status will change to Online when BigFarmNet Export has
successfully connected to the WebAccess connection.

Known WebAccess systems:

Name
P

Rightclick on a known system to access a delete option.
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3.2 Exporting Data to CSV File or Database

After configuration of the WebAccess system, select how to store data, either in CSV File, MySQL
database or SQL Server:

Please enter Export configuration/database name and file/database format.

(E'P“'t config/database setup ) File/Database format: | csv =
Configuration name: MysQL DB
SQL Server

For description of exporting to a CSV file see chapter 3.2.1.

For description of exporting to a database see chapter 3.2.2.

3.2.1 Exporting Data for a CSV File
When data is to be exported to a .csv file format the following settings are needed:
- Configuration name
- Location
- Key values
- Time schedule

Enter the settings and click Next.

3.2.1.1 Configuration Name
The next step is select the type of file for the exported data (CSV) and to name the configuration.

Please enter Export configuration/database name and file/database format.

(Export config/database setup ) File/Database format: | CSV

Configuration name: [ My farm 4

(@) Create new file when exporting

() Append to same file when exporting

[ <Back || Net> | [ cancel |

Create new file when exporting A new CSV file will be created at every export.

Append to the same file when exporting The data is appended to the existing export file.

@ Big Dutchman
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My farm Lesv - Microsoft Excel

Tt e e L B 2 2. The CSV file may be opened using MS Excel or

o -e o FEU- EH- - A- EET % Hneogeentrer- B~ % 00 3833 ,;;.l:?:qq;:.:.: e
switype . Justering % st 3 pogrier N Otepad
= .
A [} c o | £ 6
1 DateTime Location ID
2 06-12-201213:52 Enterprise
3 06-12-201213:52 03d0f2fd-e503-4784-b242-da0a39cIcbec Fam
4 06-12-201213:52 A0 210- 13- Fi 1 36954 155 . . .
faaouns oo : s T Please note that if the export file is opened
7 106-12-201213:52 JdOf: 7ne3 163 H - M
S ooz e e e ; o v BigFarmNet Export cannot write data to it.
9 |06-12-201213:52 1dof 2f 37880 167
10 06-12-201213:57 Enterprise
11 06-12-201213:57 03d0f2fd-e503-4784-b242-da0a3%cIcbec Farm ‘ T
12 06-12-201213:57 d0f2fd- b: 1 36954 155 N N \\ X
13 06-12-201213:57 dof2te 2 37075 168 B|gFarmNet Export
14 06-12-201213:57 dof2fd-eS( 784-b: F 3 3ns3 157 H o
15 06.12-201213:57 ms 18 [My farm 1] The process cannot access the file ‘C:\Users\
- e ; == 2 ‘ kmn\Documents\My farm 1.csv' becauise it is being used
18 06-12-201214:02  Enterprise =) B R =t [
19(06-12-201214:02  03d0f2fd-e503-4784-5242-da0a39cIcHec Farm by another protess: | EJ R E = 13719 =
20 06-12-2012 14:02 2 1 36954 155
21 06-12-2012 14:02 Jd0f2fd- 784 2 37075 1.68
22 06-12-2012 14:02 dOf 2f 3 ns3 157
23 06-12-2012 14:02 d0f2fd-e503-4784-b242- 4 nss 163
24 06-12-2012 14:02 dof2fd- 5 36894 163
25 06-12-2012 14:02 JOf 2f+ 37880 167

3.2.1.2 Location

The next step is to select the locations (Enterprise, Farm, House, Section or Pen) from witch data is to be
exported. The locations are displayed in a tree view showing the hierarchy of the location structure.

Please select locations for key values entry.

PYi¥] House 1
Y] House 2
—J¥] House 3
7| House 4
) P[] House 5
: Y] House 6

<bsck || Neas | | cancel

Click a checkbox to select to export data from the location.

@ Big Dutchman
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3.2.1.3 Selection of Key Values
The next step is to select the data, called key values, to be exported. The available key values are provided

by BigFarmNet Manager.

The number of available key values can be increased by checking the Show advanced key values-

checkbox.

Please select key values to be exported.
' Available key values: Selected key values:
(= Broiler = Day
[ Birds Status
— Birds culled Birds alive
i— Birds culled yesterday L Daily gain
— Birds culled/day Dead and culled
— Birds dead Temp
) | Birds dead yesterday Ventilation req
i— Birds dead/day Animals
Dead and culled yesterday
i— Dead and culled/day
— FCR
L Mortality
— PEF
[} Feed and water
— Silo
Water B
D Show advanced key values
| cmack || nNets> | | cancel

Select/deselect key value

Click H to select a key value.

Click to deselect a key value.

Change order of key values

Click ’ to change the order of the key values in the export file.

ﬂ Big Dutchman
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3.2.1.4 Schedule for Data Export

The data export can either be started manually at any given time — by choosing a configuration in the list
and clicking E Run — or set up to run at a given interval.

If the export is to run automatically the next step is to setup a schedule for the export.

Please select if the export is to run according to a schedule.

[Tl Export according ta scheduled

ey values selection \ ’—-| m nterval (hour(s) : minutes(s

| CAUsers\kmn\Documents

cpack || nNeas> | | cancel

Run scheduled Click the checkbox to active automatic data export.

Every day at The automatic export can be set as running daily at a given time or at
a given interval (minimum 2 min. and maximum 23 hours and 59
min.).

Every

Save in folder Select a path for saving the export file.

BigFarmNet Export x E A pop-up indicates when data is automatically exported the
Start of WriteLog, [My farm 1]. (=0t first time

= J 1207
W00% (3 - i al @)
G ol ) 0

@ Big Dutchman

BigFarmNet Export




3.2.2 Exporting Data for SQL Database

When exporting to a database all available key values from all farms are exported daily at a given time of
day.

After setting up the WebAccess address (see section 3.1), the first step is to install a database for the
exported data. Big Dutchman recommends using a MySQL DB.

For more details on setting up the database please see to BigFarmNet EPM Technical Manual.

3.2.2.1 Setting Parameters for the Database Connection
The next step is to set up the connection to the database using the Database function in the Settings menu.

Set the database parameters supplied by the system administrator.

@ MySQL Settings >
Set Parameters for Connecting to MySQL DBMS
’ Hostname: localhost Name or [P address of the |
SR T MySQL database parameters.
Port: 3306
The default values are:
Wissmames [tot | Nameoftheusert ect
with.
Password: [ewes | eg.1234 PO rt 3306
| Username root
Test Col
— | Password 1234
[ |

3.2.2.2 Configuration for SQL Database
The next step is to select the type of database installed and to name the configuration.

Please enter Export configuration/database name and file/database format.

(Export config/database setup ) File/Database farmat: | MySQL DB

Configuration name: [ My farm 5

Database name: IErDiIErDB‘

Time Zone: [ (UTC+01:00) Kebenhavn, Stockholm, Oslo, Ma... -

[ <Back || met> | [ cancel

File/Database format  Select to use a MySQL database or a SQL Server.

Configuration name Name the configuration indicating the location.

Database name Name the database. The same database can be used for several different configurations
from different farms.

Don’t use spacing in the database name.

Time zone Select the time zone of the server running BigFarmNet Export.
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3.2.3 Completing Configuration Setup

The final step is to check if the settings are as required.

To complete, press [Finish] button to save this configuration.

Configuration name: My farm 4

System name: DemcFarm

Export scheduled: Yes

Every day at 9:03 hours.
Save file at: CAUsers\kmn\Documents
<Back || Fmsh | | Cancel
.csv file

To complete, press [Finish] button to save this configuration.

Export tabase setup ]
Export atabase setup )
Configuration name: My farm 3
G | ssemame Permefarm
Export scheduled: Yes

Every day at 23:00 hours.

Save to Database: Data Sources=localhost; Database=BroilerDB
<Back || Fnish | | Cancel
Database
Finish Click Finish to save the configuration. It will be available in the list in the BigFarmNet
Export window.
Cancel Click Cancel to close the wizard without saving the configuration.

ﬂ Big Dutchman.
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4 Minimizing the Program

E.li?firg,l:,et EXpORE FUNEIG I DiskGeguag = = Clicking the X in the upper right corner will only

minimize the program to the task bar tray area.

To resize the program click the Show hidden icons
button and choose the BigFarmNet icon.

TECHNICAL DATA

PC minimum requirements for operating BigFarmNet Export

Processor: Dual Core CPU

RAM: 4 GB

Hard disk 5 GB fri plads

Font size on PC Standard 96 dpi

Network interface card (Ethernet):  The PC is to be connected to house computers and BigFarmNet WebLink
via LAN

Operating system: Windows 7 32bit og 64bit, Windows 8, Windows 10

Database for Export MySQL db, SQL server
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